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1. [bookmark: _Refd18e1045][bookmark: _Tocd18e1045][bookmark: _Refd18e898][bookmark: _Tocd18e898][bookmark: _Toc54942017] Getting Started
Welcome to your new Brailliant™ BI 40X Braille display. 
This user guide provides instructions for orientation, usage, navigation, and updating of the device. For more information please refer to the Brailliant BI 40X product page on the HumanWare website or call your nearest HumanWare supplier.
1.1. [bookmark: _Toc54942018]In the Box
The box contains the following items:
· Brailliant™ X Series braille display
· USB-C to USB-A cable
· USB to AC adapter
· Carrying case with lanyard
· Print Getting Started guides
1.2. [bookmark: _Toc54942019]Orientation of Brailliant BI 40X
[bookmark: _Refd18e916][bookmark: _Tocd18e916]The Brailliant BI 40X has a 40-cell braille display, a Perkins-style keyboard, two Space bars, a Home button, three command keys either side of the braille display (six in total), and four thumb keys for navigation. 
1.2.1. [bookmark: _Toc54942020]Top Face
The top face of the Brailliant can be divided into two sections: front and rear.
The front section of the top face consists of a refreshable braille display containing 40 braille cells and 40 cursor routing buttons, and 6 command keys. Each cursor routing button is associated with the braille cell directly below it. When editing text, pressing one of the cursor routing buttons moves the editing cursor to the associated braille cell. For any other instance, pressing any cursor button activates a selected item. 
When you are not editing text, any cursor button activates a selected item. 
The Command keys can be found on either side of the Braille display, three to the left and three to the right. On the left, starting from the back, are C1, C2 and C3, which is the one nearest you. On the right side, you will find C4, C5 and C6 nearest you. 
The rear section of the top face includes a Perkins-style braille keyboard where each key represents a Dot on a braille cell. The keys under your left hand represent Dots 1, 2, 3, and Backspace, where Dot 1 is located under your index finger and Backspace under your little finger. The keys under your right hand represent Dots 4, 5, 6, and Enter, where Dot 4 is located under your index finger and Enter under your little finger. There is a speaker on each side, for stereo sound, and an integrated microphone next to the right speaker (currently not active).
The Braille keyboard and command keys can be used to type Braille or perform commands. The commands depend on the screen reader used.
1.2.2. [bookmark: _Refd18e959][bookmark: _Tocd18e959][bookmark: _Toc54942021]Front Edge
On the front edge of the Brailliant are five buttons. From left to right, the buttons are as follows:
· Previous thumb key
· Left thumb key 
· Home button (circular shape) – used to return to the Main menu or exit Terminal mode
· Right thumb key
· Next thumb key
1.2.3. [bookmark: _Refd18e983][bookmark: _Tocd18e983][bookmark: _Toc54942022]Left Edge
On the left edge, from front to back are the following:
· USB-A port 
· Power button – press and hold this button for 2 seconds to turn the device ON. 
· Green LED – visually indicates the status of the device
· USB-C port – use the cable that came with your Brailliant to connect it to a power outlet or a PC.
1.2.4. [bookmark: _Toc54942023][bookmark: _Refd18e1016][bookmark: _Tocd18e1016]Right Edge
On the right edge, from front to back are the following:
· Two volume buttons (Currently not active)
· 3.5mm Audio jack (Currently not active)
1.2.5. [bookmark: _Refd18e1026][bookmark: _Tocd18e1026][bookmark: _Toc54942026]Bottom Side
Underneath your Brailliant are two large sections of anti-slip rubber pads, one on each side. 
In the middle, closer to the front edge is a slightly indented rectangle with a different texture. In this rectangle is a sticker containing printed hardware information about your Brailliant. Above the sticker, there is a braille label containing the serial number of your device.
1.3. [bookmark: _Refd18e1101][bookmark: _Tocd18e1101][bookmark: _Toc54942027]Charging Brailliant BI 40X
Prior to using your Brailliant, make sure it is charged completely. 
Connect the USB-C end of the recharge cable to the USB-C port located on the left edge of your Brailliant. Minimal effort is required and forcing the connection can damage the cable or the device. 
Connect the USB-A end of the recharge cable to the power adapter, then plug the power adapter into a power outlet. Use the provided power adapter for optimal recharge.
[bookmark: _Numd18e1123][bookmark: _Refd18e1123][bookmark: _Tocd18e1123]Alternatively, you can charge the device using your computer and the USB-A to USB-C recharge cable, but note that this method of charging is slower than charging with a power adapter.
1.4. [bookmark: _Toc54942028]Powering On and Off
The Power button is on the left edge of the Brailliant; it is oval-shaped. 
If your device is charged, press and hold the Power button for approximately 2 seconds to power on the Brailliant. There is a quick vibration and “starting” appears on the braille display along with a tactile loading animation that circles during start-up. 
A few moments after you boot your device for the first time, you will be welcomed with a language selection menu. Press Enter to open the list of languages, select one and press Enter to close the list. Close the dialog box once the changes are completed.
After a few seconds, the start-up is complete and “terminal” appears on the braille display. Your Brailliant is now ready for use. 
To power Off, press and hold the Power button for approximately 2 seconds. A confirmation message appears on the braille display. Select Ok by pressing the Previous or Next thumb key, then press Enter or a Cursor-routing key.
Alternatively, you can follow these steps to power Off the Brailliant:
1. Press P to reach the Power Off menu item.
2. Press Enter or a cursor routing key.
3. Select Ok by pressing the Previous or Next thumb key.
4. Press Enter or a cursor routing key.
1.5. [bookmark: _Toc54942029][bookmark: _Refd18e1174][bookmark: _Tocd18e1174]Adjusting the Sleep Mode 
To preserve the battery, Brailliant goes into Sleep mode after 5 minutes of inactivity. You can adjust the length of time in the Options. You can also manually put your device into Sleep mode by a short press of the power button. 
To wake up the device, press the Power button.
1.6. [bookmark: _Toc54942030]About the About Menu
The About menu provides various information about your device, such as version numbers, model number, serial number, licenses, and copyright.
To open the About Menu:
1. Go to the Main menu.
2. Select Options.
3. Press Enter. 
4. Go to the About item.
5. Press Enter. 
Alternatively, you can use the shortcut Space + I to open the About dialog. 
1.7. [bookmark: _Toc38273993][bookmark: _Toc416443718][bookmark: _Toc54942031]Launching the Main Menu
The KeySoft Main menu is your Brailliant’s default home menu. From the main menu, you can access all KeySoft Lite applications. When you start your Brailliant or close an application, you automatically return to this menu.
You can at any time return to the main menu by simply pressing the Home button on your Brailliant (the button shaped like a circle located on the front edge of your Brailliant, in the middle). Alternatively, you can use the Go to Main Menu command on the keyboard by pressing SPACE with DOTS 1 2 3 4 5 6. 

2. [bookmark: _Toc54942032] Navigating and Using Menus
KeySoft Lite is the heart of your Brailliant BI 40X, supporting all applications that are built in your braille display. KeySoft’s main menu can also be customized, which will allow you to hide and unhide applications from the Main menu. More information on customizing your Main Menu can be found in the Customize KeySofts Main Menu section.
2.1. [bookmark: _Toc54942033]Navigating the Main Menu
The Main menu contains the following items:
· Terminal
· Editor: KeyPad
· Victor Reader
· File manager : keyFiles
· Calculator : keyCalc
· Date and time
· Options
· Online services
· User guide
· Power Off
Press the Previous or Next thumb keys to scroll through the list to the menu item of your choice. Then press Enter or a cursor routing key to access it.
[bookmark: _Refd18e1251][bookmark: _Tocd18e1251]You can return to the Main menu at any time by pressing the Home button or Space with all six Dots.
2.2. [bookmark: _Toc54942034]Panning Text on the Braille Display
Often times the text on the braille display is too long to fit on a single line. To read the entire sentence, scroll or “pan” the text ahead or back by pressing the Left and Right thumb keys on the Brailliant. The Left and Right thumb keys are the second and third buttons on the front edge of the device. 
2.3. [bookmark: _Refd18e1266][bookmark: _Tocd18e1266][bookmark: _Toc54942035]Using the Context Menu for Additional Functions
The Contextual Menu lists all available actions for the KeySoft application you are currently working in as well as their associated commands. It can be very useful when you forget how to do a specific command. 
To activate the Context Menu, press Space + M. A menu opens with a list of actions you can perform at that particular moment. Scroll through the menu to the desired action and press Enter or a cursor routing key. 
Press Space + E to exit the Context Menu.
2.4. [bookmark: _Toc54942036]Navigating by First Letters of Words
Most of the time, you can jump to an item in a menu by typing the first letter of that item. Doing so automatically moves your focus to the first item in the list starting with that letter. Typing the same letter twice moves the focus to the second item in the list starting with that letter, and so on. 
For example, to reach the Options menu on the Brailliant, you type the letter ‘O’ on your keyboard.
Note that KeySoft apps found on your main menu are optimized for first letter navigation.
2.5. [bookmark: _Refd18e1309][bookmark: _Tocd18e1309][bookmark: _Toc54942037]Using Shortcuts/Key Combinations to Navigate
As the name implies, shortcuts, also known as key combinations, make it easy to quickly navigate through a menu or file. 
The most commonly used shortcuts on the Brailliant BI 40X are indicated in Table 1.
Table 1: Shortcut/Key Combination Table
	Action
	Shortcut or Key Combination

	Activate Selected item
	Enter or cursor routing key

	Escape or Back
	Space + E

	Previous item
	Previous thumb key, C1 or Space + Dot 1

	Next item
	Next thumb key, C3 or Space + Dot 4

	Jump to any item in a list
	Type the first letter of the item or app

	Pan left and right
	Left or Right thumb key or C2 (pan left) and C5 (pan right)

	Go to top
	Space + Dots 1-2-3

	Go to bottom
	Space + Dots 4-5-6

	Toggle Braille grade
	Backspace + G

	Switch Braille profile
	Enter + L or C4 

	Battery level
	Enter + P

	Context menu
	Space + M

	Main menu
	Space + Dots 1-2-3-4-5-6 or Home button

	System information
	Space + I

	Time
	Enter + T

	Date
	Enter + D

	Eject media
	Enter + E

	Options
	Space + O



Note: All commands that include Enter or Backspace must have the Space Bar added to them when using computer braille.
3. [bookmark: _Refd18e1364][bookmark: _Tocd18e1364][bookmark: _Toc54942038] Using the KeyPad Application
KeyPad is an application that allows you to open, edit, and create text files on the Brailliant. You can open .docx, .doc, .txt, .brf, and .brl files with KeyPad. The files you create or modify are saved as a .txt file.
To open KeyPad, press the Next thumb key until you reach Editor:KeyPad or press ‘e’ in the Main menu, then press Enter or a cursor routing key.
KeyPad opens a sub menu, which includes Create file, Open file, Editor settings, and Close.
3.1. [bookmark: _Refd18e1411][bookmark: _Tocd18e1411][bookmark: _Toc54942039]Create a File
There are several ways to create a file depending on your current location on the device. 
· If you are in the KeyPad menu, select Create file and press Enter or a cursor routing key.
· From the Context menu, select and activate File menu, then Create file. 
· Press Backspace + N in the KeyPad app.
The cursor is visible between two braille brackets. You can begin writing in your new file. 
3.2. [bookmark: _Refd18e1434][bookmark: _Tocd18e1434][bookmark: _Toc54942040]Open a File
If you are in the KeyPad menu, select Open file and press Enter or a cursor routing key. From any other location, press Backspace + O, then select the file you wish to open using the Previous and Next thumb keys.
3.3. [bookmark: _Refd18e1452][bookmark: _Tocd18e1452][bookmark: _Toc54942041]Close a File
To close a file that is opened in KeyPad, press Space + E. Alternatively, open the Context menu using Space + M, then scroll to and activate the File menu. Select Close file item.
If there are changes to your file that have not been saved, you are asked if you want to save the changes before closing.
3.4. [bookmark: _Refd18e1472][bookmark: _Tocd18e1472][bookmark: _Toc54942042]Save a Text File
There are two types of saving in KeyPad: Save and Save as.
Save: Press Space + S to save your file to an already existing filename.
Save as: Press Backspace + S to save a copy of your file with a new filename and change the location.
If your file has never been saved, KeyPad asks you to enter a new filename regardless of the save method you choose.
3.5. [bookmark: _Toc54942043]Auto Scrolling Through Written Text in the KeyPad
The KeyPad app features an Auto Scroll functionality that automatically pans through the written text on the braille display. 
To start Auto Scrolling, press Enter + Dots 1-2-4-5-6 or C6. 
To stop Auto Scrolling, press any key.
3.5.1. [bookmark: _Refd18e1514][bookmark: _Tocd18e1514][bookmark: _Toc54942044]Modifying Auto Scroll Speed
You can change the Auto Scroll speed when auto-scrolling inside a file. 
To slow down Auto Scroll, press Enter + Dot 3.
To speed up Auto Scroll, press Enter + Dot 6.
3.6. [bookmark: _Refd18e1529][bookmark: _Tocd18e1529][bookmark: _Toc54942045]Finding Text in a File
To find text in your file, press Space + F. Enter your search term in the blank field. Your cursor is placed at the first location the text is found. 
Press Space + N to find additional instances of the search word. 
Press Space + P to reach previous instances of the search word.
3.6.1. [bookmark: _Refd18e1541][bookmark: _Tocd18e1541][bookmark: _Toc54942046]Finding and Replacing Text
To find and replace text: 
1. Press Backspace + F. 
2. [bookmark: _Hlk37858074]Enter the text to find in the first edit box.
3. Enter the text to replace it within the second prompted edit box.
4. Press the Next button to find the next instance of the word. 
5. Press the Next button to find Replace All. 
3.7. [bookmark: _Refd18e1554][bookmark: _Tocd18e1554][bookmark: _Toc54942047]Cutting, Copying, and Pasting Text
KeyPad lets you cut, copy, and paste text in a way similar to computer programs. 
To select the text, position your cursor on the first character using a cursor routing button, then press Enter + S. 
Alternatively, you can select text from the Context menu:
1. Open the Context menu with Space + M. 
2. Scroll down to Edit.
3. Press Enter or a cursor routing key. 
4. Scroll down to Select Text. 
5. Press Enter or a cursor routing key.
This marks the start of your selection. Now go to the location at the end of your selection, and press EnterSpace + S to end the selection.
To select All text included in the file, press Enter + Dots 1-2-3-4-5-6.
To Copy the selected text, press Backspace + Y.
To Cut the selected text, press Backspace + X.
To Paste the copied or cut text, position your cursor where you want the text to be pasted using a cursor routing button and press Backspace + V.
As always, these commands can be accessed through the Context menu.
3.8. [bookmark: _Refd18e1601][bookmark: _Tocd18e1601][bookmark: _Toc54942048]Using the Read Mode
Read mode allows you to read files without the possibility of editing content by mistake. You cannot edit files while in Read mode. 
To activate or deactivate Read mode, press Space + X.
To activate or deactivate Read mode from the Context menu:
1. Press Space + M to activate the Context menu.
2. Scroll to File using the Previous and Next thumb keys.
3. Press Enter or a cursor routing key. 
4. Scroll to Read mode using the Previous and Next thumb keys.
5. Press Enter or a cursor routing key.
3.9. [bookmark: _Toc54942049]Inserting Date and Time
When creating a file in the KeyPad application, you have the option to insert the current date and time in the file. 
To insert date and time:
1. Press Space + M to activate the Context menu.
2. Scroll to  Edit using the Previous and Next thumb keys.
3. Press Enter or a cursor routing key. 
4. Scroll to Insert using the Previous and Next thumb keys.
5. Press Enter or a cursor routing key. 
6. Scroll to Insert date  or Insert time using the Previous and Next thumb keys.
7. Press Enter or a cursor routing key.
3.10. [bookmark: _Refd18e1625][bookmark: _Tocd18e1625][bookmark: _Toc54942050]KeyPad Commands Table
The KeyPad commands are listed in Table 2.
Table 2: KeyPad Commands
	Action
	Shortcut or Key Combination

	Activate edit mode
	Enter or a cursor routing key

	Leave edit mode
	Space + E

	Create file
	Backspace + N

	Open file
	Backspace + O

	Save
	Space + S

	Save as
	Backspace + S

	Find 
	Space + F

	Find next
	Space + N

	Find previous
	Space + P

	Replace
	Backspace + F

	Start/Stop selection
	Enter + S

	Select all 
	Enter + ADots 1-2-3-4-5-6

	Copy
	Backspace + Y

	Cut
	Backspace + X

	Paste
	Backspace + V

	Delete previous word
	Backspace + Dot 2

	Delete current word
	Backspace + Dots 2-5

	Delete previous character
	Backspace 

	Move to next edit box while editing
	Enter 

	Move to next edit box without editing
	Next thumb key

	Move to previous edit box without editing
	Previous thumb key

	Move insertion point to start of text field document
	Space + Dots 1-2-3 

	Move insertion point to end of text field document
	Space + Dots 4-5-6 

	Start auto-scroll
	SpaceEnter + Dots 1-2-4-5-6 or C6

	Increase auto-scroll speed
	Enter + Dot 6

	Decrease auto-scroll speed
	Enter + Dot 3

	Toggle Reading mode 
	Space + X



4. [bookmark: _Refd18e1672][bookmark: _Tocd18e1672][bookmark: _Toc54942051] Using Victor Reader
Victor Reader is the application you use to read books on the Brailliant. It supports the file formats .brf, .pef, .txt, .html, .docx, DAISY, and .rtf, and is compatible with .zip files containing books in text format.
To open the Victor Reader app, press the Next thumb key until you reach Victor Reader, or press ‘V’ in the Main menu. Press Enter or a cursor routing key to access the app.
The Victor Reader menu includes Book list, Recently read, Search, and Close.
4.1. [bookmark: _Toc54942052]Navigating the Book List
In Victor Reader, your books are stored in a Book list, comparable to a directory containing all the available media on your device in alphabetical order.
Use the Previous and Next thumb keys to select a book from your Book list, then press Enter or a cursor routing key.
To close a book and return to the Book list, press Space + E or Space + B.
4.1.1. [bookmark: _Refd18e1750][bookmark: _Tocd18e1750][bookmark: _Toc54942053]Searching for Books
To search for a specific book on the device: 
1. [bookmark: _Hlk37858943]Select Search from the Victor Reader menu or press Space + F. 
2. Type in the text/name of book.
3. Press Enter. 
You are presented with a list of books matching your search criteria. 
4. Use the Previous and Next thumb keys to scroll to the book.
5. Press Enter or a cursor routing key to open it.
4.1.2. [bookmark: _Toc54942054]Accessing Recently Opened Books
You can open a list of the last five books you previously opened for quick access.
To open a list of the five most recent books, press Enter + R or select Recently read from the Victor Reader menu. 
You can scroll through the five most recent books using the Previous and Next thumb keys. Press Enter or a cursor routing key to open a book from the list.
4.1.3. [bookmark: _Toc54942055][bookmark: _Numd18e1803][bookmark: _Refd18e1803][bookmark: _Tocd18e1803]Managing Your Books
When browsing the Book list, you can copy, move, or delete a selected book from the Victor Reader application to an external storage device. The actions that are available for each book depend on the type and location of the book. The Context menu tells you what actions are available.
The basic rules are:
· [bookmark: _Hlk37860446]Books located on the USB storage can be deleted.
· Books downloaded from online services can be moved or deleted.
· Books can only be copied or moved to/from when external storage is connected. 
· You are unable to copy or move books from within the internal storage. 
To copy, move, or delete a book:
1. Access the book list by pressing Space + B. 
2. Select a book using the Previous or Next thumb keys.
3. Press Backspace + M to open the Manage Book menu. 
4. Select Copy to, Move to, or Delete. 
4.2. [bookmark: _Toc54942056]Navigating and Accessing Additional Information in Books
The easiest way to navigate inside a book is by using the thumb keys. Use the Left and Right thumb keys to pan the text left and right. 
4.2.1. [bookmark: _Refd18e1812][bookmark: _Tocd18e1812][bookmark: _Toc54942057]Changing the Navigation Level for Books
[bookmark: _Hlk37860605]The Victor Reader includes different navigation levels to make navigating through a book easier. Navigation levels are dependent on each book and may differ from book to book. 
To change the Navigation level:
1. [bookmark: _Hlk37860740]Press Space + T.
2. Scroll through the available Navigation levels using the Previous and Next thumb keys.
3. Press Enter or a cursor routing key to select the Navigation level.
Once the Navigation level is selected, use the Previous and Next thumb keys to navigate at this Navigation level. 
For example, if you selected the "Sentence" Navigation level, pressing the Next thumb key would move you from sentence to sentence within the book.
4.2.2. [bookmark: _Toc54942058]Navigating by Page, Heading, Percentage, or Bookmarks
To reach a specific page, heading, book percentage, or bookmark:
1. Press Enter + G. 
2. Scroll through the navigation options using the Previous and Next thumb keys.
3. Choose between Page, Heading, Percent, or Bookmark.
4. Press enter or a cursor routing key. 
5. Enter a value.
6. Press Enter.
4.2.3. [bookmark: _Refd18e1869][bookmark: _Tocd18e1869][bookmark: _Toc54942059]Auto-Scrolling Through Text in Books in the Victor Reader App
[bookmark: _Hlk37861688]The Auto-scroll feature of the Brailliant BI 40X allows you to scroll through the text of an open book automatically. 
To turn On Auto-scroll, press EnterSpace + Dots 1-2-4-5-6 or C6 when inside a book. Press any key to stop the Auto-scroll and return to the regular Panning mode.
You can modify the Auto-scroll speed when auto-scrolling inside a book. 
[bookmark: _Numd18e1900][bookmark: _Refd18e1900][bookmark: _Tocd18e1900]To slow down Auto-scroll, press Enter + Dot 3. 
To speed up Auto-scroll, press Enter + Dot 6.
4.2.4. [bookmark: _Toc54942060]Finding Your Current Position in a Book
Use the Where am I command whenever you need to know your current position within a book. 
To activate the Where am I command, press Space + Dots 1-5-6.
Alternatively, access the Context menu by pressing Space + M. Go to Where am I using the Previous and Next thumb keys, then press Enter or a cursor routing key to activate the item.
Use the Previous and Next thumb keys to scroll through the available elements (Heading, Percent, Page, and Line). Use the Left and Right thumb keys to pan the text left and right.
4.2.5. [bookmark: _Refd18e1925][bookmark: _Tocd18e1925][bookmark: _Toc54942061]Navigating to the Beginning or End of a Book
You can reach the beginning or end of a book using shortcuts. 
To reach the beginning of a book, press Space + Dots 1-2-3. 
To reach the end of a book, press Space + Dots 4-5-6.
4.2.6. [bookmark: _Refd18e1940][bookmark: _Tocd18e1940][bookmark: _Toc54942062]Searching for Text in a Book
Another way to navigate within a book is to search for a specific string of text. 
To search for text, press the Space + F command. You are prompted to enter the text. Type the text, then press Enter.
4.2.7. [bookmark: _Refd18e1955][bookmark: _Tocd18e1955][bookmark: _Toc54942063]Accessing Additional Book Information
You can display additional information about the book you are currently reading on the device (title, author, description, date, language, subject, publisher, and bookmarks).
To display additional book information, press Space + I. 
You can also press Space + M to open the Context menu. Use the Previous and Next thumb keys to select the Book Information menu item, then press Enter or a cursor routing key to activate it.
Use the Previous and Next thumb keys to scroll through the available book information. Use the Left and Right thumb keys to pan the text left and right.
4.3. [bookmark: _Refd18e1986][bookmark: _Tocd18e1986][bookmark: _Toc54942064]Adding, Navigating, Highlighting, and Removing Bookmarks
Bookmarks are a useful way to keep your location within the book and allow you to return quickly to that position at a later time.
[bookmark: _Numd18e1995][bookmark: _Refd18e1995][bookmark: _Tocd18e1995]To open the Bookmark menu, press Enter + M. You can also press Space + M to open the Context menu and select Bookmark menu.
4.3.1. [bookmark: _Toc54942065]Inserting a Bookmark
To add a bookmark in a book:
1. Press Enter + M to open the Bookmark menu. 
2. Select Insert Bookmark using the Previous and Next thumb keys.
3. Press Enter or a cursor routing key. 
4. Enter a specific unused bookmark number. 
Note: If you do not enter a number, Brailliant selects the first available number and assigns it to the bookmark.
5. Press Enter. 
Alternatively, you can insert a Quick Bookmark by pressing Enter + B.
4.3.2. [bookmark: _Refd18e2026][bookmark: _Tocd18e2026][bookmark: _Toc54942066]Navigating to Bookmarks
To jump to a bookmark, press Enter + J. You are prompted to enter the bookmark number. Enter the bookmark number you wish to navigate to, then press Enter.
4.3.3. [bookmark: _Refd18e2041][bookmark: _Tocd18e2041][bookmark: _Toc54942067]Highlighting Bookmarks 
[bookmark: _Hlk37863095]The Highlight Bookmarks menu item is used to define the Start and the End positions of a passage. Using highlighted bookmarks is a great way to study important passages in textbooks.
To highlight bookmarks:
1. Open the Bookmark menu by pressing Enter + M.
2. Select Highlight Bookmark Start using the Previous and Next thumb keys.
3. Press Enter or a cursor routing key. 
4. Enter a specific unused bookmark number.
Note: If you do not enter a number, your Brailliant selects the first available number and assigns it to the bookmark.
5. Press Enter. 
6. Navigate to the end point of the highlighted passage. 
7. Open the Bookmark menu by pressing Enter + M. 
8. Select Highlight Bookmark End using the Previous and Next thumb keys.
9. Press Enter or a cursor routing key. 
The current position is set as the ending position. If the end position is placed before the start position, they are switched. 
You can also insert a Quick Bookmark. It is used to mark the end of the Highlight Bookmark.
To insert a Quick Bookmark:
1. Press Enter + H to open the Highlight Bookmark list. 
2. Select a Highlight Bookmark number.
3. Press Enter. 
The content of the current Highlight Bookmark is displayed. 
4. Use the thumb keys to navigate. 
5. Press Space + E to close the Highlight Bookmark and return to the entire book content.
4.3.4. [bookmark: _Refd18e2067][bookmark: _Tocd18e2067][bookmark: _Toc54942068]Removing Bookmarks
To remove a saved Bookmark:
1. Press Enter + M to open the Bookmark menu. 
2. Scroll to Remove Bookmark using the Previous and Next thumb keys.
3. Press Enter or a cursor routing key. 
4. Enter the Bookmark number you want to remove.
5. Press Enter.
[bookmark: _Refd18e2091][bookmark: _Tocd18e2091]Note: If you want to remove all bookmarks type 99999 when prompted Bookmark number.
4.4. [bookmark: _Toc54942069]Victor Reader and Reading Commands Table
The Victor Reader and reading commands are listed in Table 3.
Table 3: Victor Reader/Reading Commands
	Action
	Shortcut or Key Combination

	Book list 
	Space + B

	Manage books
	Backspace + M

	Go to Option menu
	Enter + G

	Bookmark menu
	Enter + M

	Jump to bookmark
	Enter + J

	Insert Quick Bookmark
	Enter + B

	Show Highlight Bookmarks
	Enter + H

	Open Navigation level
	Space + T

	Previous element
	Previous thumb key

	Next element
	Next thumb key

	Start Auto-scroll
	Enter + Dots 1-2-4-5-6 or C6

	Increase Auto-scroll speed
	Enter + Dot 6

	Decrease Auto-scroll speed
	Enter + Dot 3

	Where am I
	Space + Dots 1-5-6

	Info
	Space + I

	Go to beginning of book
	Space + Dots 1-2-3

	Go to end of book
	Space + Dots 4-5-6

	Open recent books 
	Enter + R

	Search for books or text
	Space + F

	Find next
	Space + N

	Find previous
	Space + P

	Next non-blank line
	Enter + Dot 4

	Previous non-blank line
	Enter + Dot 1

	Previous character
	Space + Dot 3

	Next character
	Space + Dot 6 

	Previous word
	Space + Dot 2

	Next word
	Space + Dot 5

	Previous paragraph
	Space + Dots 2-3

	Next paragraph
	Space + Dots 5-6



5. [bookmark: _Refd18e2191][bookmark: _Tocd18e2191][bookmark: _Toc54942070] Using Terminal Mode
One of the main features of the Brailliant is Terminal mode. When connected to a host device running a screen reader, such as a computer or a smart device, Terminal Mode displays all text selected on the host device. 
You can connect to your host device either through Bluetooth® wireless technology, or by connecting the USB-C cable included with your Brailliant to the host device. Up to five Bluetooth devices and one USB can be connected at one time.
5.1. [bookmark: _Refd18e2226][bookmark: _Tocd18e2226][bookmark: _Toc54942071]Connecting and Exiting Terminal Mode
To connect in Terminal mode, make sure you have a Windows®, iOS®, or Mac® device with a screen reader running.
To activate Terminal mode:
1. Press Space + Dots 1-2-3-4-5-6 or the Home button to enter the Main menu.
2. Go to Terminal by pressing ‘t’ or by using the Previous and Next thumb keys.
3. Press Enter or a cursor routing key.
To exit Terminal mode and access the list of connected devices, press the Home button once.
5.1.1. [bookmark: _Toc54942072]Determining Brailliant BI 40X Compatibility
The Brailliant is compatible with the following:
Screen readers: JAWS® 18+ (version 18 and newer), NVDA, SuperNova and VoiceOver 
Operating systems: any Windows 8+, macOS® 10.15+ (Catalina), or iOS device 13.4+ 
5.1.2. [bookmark: _Toc54942073]Waking Your iOS Device Using the Brailliant 
With your iOS device locked, pressing any cursor routing keys on the Brailliant wakes it up to enter your passcode. This allows you to keep your iOS device in a pocket or bag while you use the Brailliant as its controller and output.
5.1.3. [bookmark: _Toc54942074]Connecting by USB
To connect via USB:
1. Connect the Brailliant to a Windows or Mac computer with the USB-C cable. 
2. Select Connected devices (first item in the Terminal menu).
3. Press Enter. 
4. Select USB connection.
5. Press Enter.
6. Wait for the connection to be established. 
If the connection is successful, the content of your host device is shown on the braille display. 
The Brailliant is now also available as an external keyboard to type on the host device.
5.1.4. [bookmark: _Toc54942075]Connecting by Bluetooth
To pair a new device in Bluetooth:
1. Click Add Bluetooth device. 
If Bluetooth is Off, it is automatically activated. 
2. Read instructions on the display; press Enter to dismiss the message. 
The focus returns to the menu item. 
3. From the host device, initiate the Bluetooth pairing.
4. Once the connection is complete, press the Previous thumb key on the Brailliant until you reach Connected devices.
5. Press Enter or a cursor routing key. 
The connected device appears in the list. 
6. Press Enter or a cursor routing key.
7. Wait for the connection to be established. 
If the connection is successful, the content of your host device is shown on the braille display. 
[bookmark: _Numd18e2335][bookmark: _Refd18e2335][bookmark: _Tocd18e2335]The Brailliant is now also available as an external keyboard to type on the host device.
5.2. [bookmark: _Toc54942076]Navigating Between Connected Devices
When you have more than one device connected with the Brailliant, you can switch devices at any time. 
To switch to another connected device: 
1. Press the Home button to return to the list of connected devices.
2. Select the connected device using the Previous and Next thumb keys.
3. Press Enter or a cursor routing key.
Note: When a Bluetooth device is connected, an 8-dot symbol is displayed after the device name. If the 8-dot symbol is not visible, click on the device to establish the connection. 
If you have problems with a Bluetooth connection, you can click on Reconnect devices. This turns Bluetooth Off and back On and reconnects your devices. Use this option only if you are not getting any braille when connected to a device.
6. [bookmark: _Refd18e2347][bookmark: _Tocd18e2347][bookmark: _Toc54942077] Using KeyFiles
KeyFiles allows you to browse, delete, copy, and perform all the file operations you would expect from a PC file manager.
To open KeyFiles, press the Next thumb key until you reach File Manager : KeyFiles. 
Alternatively, you can open KeyFiles by pressing F in the Main menu, then press Enter or a cursor routing key.
6.1. [bookmark: _Refd18e2364][bookmark: _Tocd18e2364][bookmark: _Toc54942078]Browsing Files
You can browse through your files and folders using the Previous and Next thumb keys. Folder names have an 8-dot symbol in front of the folder name. Press Enter on a folder to open it.
Press Space + E to return to the parent folder. Alternatively, you can scroll to the Back item, then press Enter or a cursor routing key.
6.1.1. [bookmark: _Refd18e2389][bookmark: _Tocd18e2389][bookmark: _Toc54942079]Selecting a Drive in KeyFiles
Before using KeyFiles, you first need to choose which drive you wish to access: the internal memory or a USB flash drive. 
To select a drive, press Space + D to display a list of available drives. Scroll through the list using the Previous or Next thumb keys, then press Enter or a cursor routing key to confirm your choice. 
You are now at the root of your selected drive.
Press Space + D at any time to return to the Drive Selection screen.
6.1.2. [bookmark: _Refd18e2419][bookmark: _Tocd18e2419][bookmark: _Toc54942080]Accessing File and Folder Information
To get additional information on a file or folder, select it using the Previous or Next thumb keys, then press Space + I.
You can now scroll through a list of information on the file or folder using the Previous and Next thumb keys. Use the Left and Right thumb keys to pan the text left and right.
6.1.3. [bookmark: _Refd18e2445][bookmark: _Tocd18e2445][bookmark: _Toc54942081]Displaying the Current File Path
The Where Am I function allows you to display the path of your current location on the braille display of the Brailliant.
To display your current file path, press Space + Dots 1-5-6.
6.1.4. [bookmark: _Refd18e2462][bookmark: _Tocd18e2462][bookmark: _Toc54942082]Searching for Files and Folders
You can promptly access a certain file or folder by performing a search in KeyFiles.
To start searching for a file or folder in KeyFiles:
1. Press Space + F.
2. Type in the file or folder name.
3. Press Enter.
A list of files and folders related to your search results is generated on the braille display.
4. Press Space + E to close the search result.
6.1.5. [bookmark: _Refd18e2486][bookmark: _Tocd18e2486][bookmark: _Toc54942083]Sorting Files or Folders
By default, file and folder names are sorted alphabetically. However, you can sort the files and folders using different parameters.
To change the sorting parameters of your files and folders:
1. Press Space + V.
Brailliant displays a list of sorting options available: Name, Date, Size, and Type. 
2. Scroll through the list using the Previous or Next thumb key.
3. Press Enter or a cursor routing key to activate the sorting option of your choice. 
Selecting the same sorting parameter already selected, changes the information from ascending to descending and back again when selected once more.
6.2. [bookmark: _Refd18e2518][bookmark: _Tocd18e2518][bookmark: _Toc54942084]Modifying Files and Folders
KeyFiles on the Brailliant lets you work with files similarly to a computer or tablet. 
6.2.1. [bookmark: _Refd18e2530][bookmark: _Tocd18e2530][bookmark: _Toc54942085]Creating a New Folder
KeyFiles gives you the possibility to create new folders. 
The simplest way to do this is by pressing Space + N and entering the name of the new folder in the blank field. Then, press Enter to create it.
6.2.2. [bookmark: _Refd18e2547][bookmark: _Tocd18e2547][bookmark: _Toc54942086]Renaming Files or Folders
To rename a file or folder:
1. Select the file or folder you wish to rename using the Previous and Next thumb keys. 
2. Press Backspace + R.
3. Enter the new file or folder name.
4. Press Enter to rename the file or folder.
Note: The file name must be unique in your current directory, and only one file or folder can be renamed at a time. 
6.2.3. [bookmark: _Refd18e2572][bookmark: _Tocd18e2572][bookmark: _Toc54942087]Selecting Files or Folders for Applying Additional Actions
Before you can perform an action on a file or folder, such as cut, copy, or paste, you must first select (or Mark) the desired file or folder. 
To Mark a file or folder, select the file using the Previous or Next thumb keys, then press Backspace + L.
To Unmark a file or folder, select it and press Backspace + L again.
To Mark All files and folders in the current directory, press Enter + Dots 1-2-3-4-5-6.
6.2.4. [bookmark: _Refd18e2652][bookmark: _Tocd18e2652][bookmark: _Toc54942088][bookmark: _Refd18e2602][bookmark: _Tocd18e2602]Copying, Cutting, and Pasting Files or Folders
Copying and Cutting Files and Folders
To copy a single file or folder, select the file using the Previous or Next thumb keys, then press Backspace + Y.
To cut a single file or folder, select the file using the Previous or Next thumb keys, then press Backspace + X.
To copy or cut multiple files or folders: 
1. Select the file or folder to copy using the Previous or Next thumb keys. 
2. Press Backspace + L to Mark the file or folder.
3. Repeat this step to Mark all files or folders to be copied.
4. Press Backspace + Y to copy OR Backspace + X to cut. 
The files or folders are now copied/cut to the clipboard and ready to be pasted.
Pasting Files and Folders
To paste the copied or cut files or folders, navigate to the location where you want to paste to, then press Backspace + V.
6.2.5. [bookmark: _Toc54942089]Deleting Files or Folders
To delete a single file or folder, select the file using the Previous or Next thumb keys, then press Backspace + Dots 2-3-5-6.
To delete multiple files or folders:
1. Select the file or folder you wish to delete using the Previous or Next thumb keys. 
2. Once selected, press Backspace + L to Mark the file or folder.
3. Repeat this step to Mark all files or folders you wish to delete.
4. When ready to delete the Marked files or folders, press Backspace + Dots 2-3-5-6. 
Note: Brailliant asks if you are sure you want to delete the files and/or folders only when user Confirm Deletion has been set to On in the Options menu. Select Yes using the Previous or Next thumb keys, and press Enter or a cursor routing key to confirm the deletion. For more information on the Confirm Deletion setting, go to the Options Menu section.
6.3. [bookmark: _Refd18e2734][bookmark: _Tocd18e2734][bookmark: _Toc54942090]KeyFiles Commands Table
The KeyFiles commands are listed in Table 4.
Table 4: KeyFiles Commands
	Action
	Shortcut or Key Combination

	Create new folder 
	Space + N

	File info 
	Space + I

	Mark/Unmark
	Backspace + L

	Mark all/Unmark all 
	Enter + Dots 1-2-3-4-5-6

	Rename file
	Backspace + R

	Delete file
	Backspace + Dots 2-3-5-6

	Copy file 
	Backspace + Y

	Cut file
	Backspace + X

	Paste file
	Backspace + V

	Search file 
	Space + F

	Sort files 
	Space + V

	Where am I 
	Space + Dots 1-5-6

	Select drive 
	Space + D

	Go to parent folder
	Space + E

	Eject media
	EnterBackspace + E


7. [bookmark: _Refd18e2800][bookmark: _Tocd18e2800][bookmark: _Toc54942091] Using the KeyCalc Application
The Brailliant features a calculator app that enables you to perform the most common operations. 
Note: KeyCalc currently supports Computer Braille only. 
To open KeyCalc:
1. Go to the Main menu.
2. Press C OR press the Previous or Next thumb keys until you reach the Calculator: KeyCalc menu item. 
3. Press Enter or a cursor routing key.
7.1. [bookmark: _Toc54942092]Operating the Calculator
To use KeyCalc, write your complete equation, then press Enter to get the result. 
For example, type the equation 20-(6+8) (with no spaces). Press Enter and Brailliant displays 6 as the answer.
To clear the previous equation, press Space + Dots 3-5-6.
To add operators such as + or -, open the Context menu using Space + M. Refer to the KeyCalc Commands Table section, for a full list of KeyCalc commands and operators.
7.2. [bookmark: _Calculator_Commands_Table][bookmark: _Refd18e2847][bookmark: _Tocd18e2847][bookmark: _Toc54942093]KeyCalc Commands Table
The KeyCalc commands are listed in Table 5.
Table 5: Calculator Commands using US Computer Braille
	Action
	Shortcut or Key Combination

	Plus 
	Dots 3-4-6

	Minus
	Dots 3-6

	Multiply
	Dots 1-6

	Divide
	Dots 3-4

	Equals
	Enter

	Clear 
	Space + Dots 3-5-6

	Decimal point
	Dots 4-6

	Percent
	Dots 1-4-6

	Square root 
	Space + Dots 3-4-5

	Pi
	Space Y



8. [bookmark: _Refd18e2894][bookmark: _Tocd18e2894][bookmark: _Toc54942094] Using the Date and Time Application
The Brailliant features an application that gives you the current date and time. 
To open Date and Time:
1. Go to the Main menu.
2. Press the Previous or Next thumb keys until you reach the Date and Time menu item.
3. Press Enter or a cursor routing key.
8.1. [bookmark: _Refd18e2923][bookmark: _Tocd18e2923][bookmark: _Toc54942095]Displaying the Time and Date
When you open the Date and Time application, Brailliant displays the current time. 
Pan right once using the Right thumb key to display the date. 
Pan left using the Left thumb key to return to the time. 
To quickly review the date and time, press Enter + T for the time and Enter + D for date from anywhere on the Brailliant.
8.2. [bookmark: _Refd18e2938][bookmark: _Tocd18e2938][bookmark: _Toc54942096]Setting the Time and Date
To change the time and date, press Space + M from the Date and Time application.
A submenu opens with the following options: 
· Change time: Type the current hour inside the square brackets, press Enter; repeat for the minutes.
· Change date: Type the current year inside the square brackets and press Enter; repeat for the month and day.
· Daylight saving time: Press Enter to turn daylight saving time On or Off.
· Time format: Press Enter to change between 24h and 12h time format.
· Date format: Select the preferred date format (listed below) and press Enter. 
· Day, Month, Year 
· Month, Day 
· Month, Day, Year 
· Year, Month, Day 
· Day, Month 
9. [bookmark: _Setting_User_Preferences][bookmark: _Options_Menu][bookmark: _Refd18e2965][bookmark: _Tocd18e2965][bookmark: _Toc54942097] Options Menu
The Options menu allows you to modify the settings of your Brailliant, and contains the following items:
· User settings
· Braille profile
· Wifi
· Bluetooth
· Main menu applications 
· Change region
· Activate exam mode
· About
To open the Options menu, press the Next thumb key until you reach Options OR press ‘O’ in the Main menu, then press Enter or a cursor routing key. Alternatively, you can access the Options Menu by pressing Space + O.
10. [bookmark: _Toc54942098]User settings
10.1. [bookmark: _Refd18e2980][bookmark: _Tocd18e2980][bookmark: _Toc54942099]User Setting Options Table
The user Settings options are listed in Table 6.
Table 6: Options Operations
	Setting
	Option/Result

	Airplane mode
	On or Off; when On, all wireless functionalities are disabled

	Format Markers
	On or Off; when Off, format markers are hidden

	Cursor visible
	On or Off

	Message display time
	1–30 seconds: time of message displayed 

	Sleep time
	Number in minutes; 0 to turn Off

	Word wrap
	On or Off

	Condense blank lines
	On or Off; when On, blank lines are not visible

	Confirm deletion
	On or Off; when On, Brailliant asks for confirmation of file deletion

	Vibration
	On or Off; when On, Brailliant vibrates

	Beep
	On or Off; when On, Brailliant beeps

	Thumb keys configuration
	Map the Previous Item, Next Item, Pan Left, and Pan Right commands to the thumb key of your choice.

	Wireless notifications
	Enable or disable wireless and Bluetooth connection feedback



10.2. [bookmark: _Toc54942100]Adding, Configuring, and Deleting Braille Profiles
[bookmark: _Hlk37926202]The Braille Profile menu lists all the available Braille Profiles on your Brailliant. The active Braille Profile is underlined with dots 7 and 8 on the device. 
Scroll through the available Braille Profiles using the Next and Previous thumb keys, then press Enter or a cursor routing key to select it.
10.2.1. [bookmark: _Refd18e3042][bookmark: _Tocd18e3042][bookmark: _Toc54942101]Adding a Braille Profile
To add a Braille Profile, select Add Braille Profile, then press Enter or a cursor routing key.
You are prompted to enter the following options:
· Profile name: Type the name for the profile in the brackets, then press Enter.
· Braille grade: Choose between Uncontracted, Contracted, and Computer braille, then press Enter.
· Computer braille table: Select your computer braille table, then press Enter.
· Uncontracted braille table: Select your uncontracted braille table, then press Enter.
· Contracted braille table: Select your contracted braille table, then press Enter.
· Save configuration: Press Enter to save your configuration. 
The new Braille Profile is now available in the Braille Profile Settings menu.
10.2.2. [bookmark: _Toc54942102]Configuring or Deleting a Braille Profile
To configure or delete a Braille Profile:
1. Scroll through the available Braille Profiles using the Next and Previous thumb keys.
2. Press Space + M to open the Context menu. 
3. Select Configure Braille Profile OR Delete Braille Profile.
4. Press Enter.
10.3. [bookmark: _Refd18e3068][bookmark: _Tocd18e3068][bookmark: _Toc54942103]Using a Wi-Fi Network or Bluetooth
Brailliant BI 40X features 2.4 GHz and 5 GHz Wi-Fi capabilities.
10.3.1. [bookmark: _Connecting_to_a][bookmark: _Toc54942104]Connecting to a Wi-Fi Network
Select New Connection from the Wi-Fi menu, then press Enter or a cursor routing key to access it. 
There are three connection choices:
Scan for SSID: Select this option to discover the available networks in your vicinity. When Brailliant is done scanning, it displays a list of all the networks it found. 
Press Enter or a cursor routing key to select this network. Then enter the password, and press Enter to complete the connection.
WPS Connection: Select this option to establish a Wi-Fi Connection using WPS. The Brailliant displays “loading...” for approximately 30 seconds. Press the WPS button on your network Router to turn on discovery of new devices. After a few seconds, you are automatically connected to the network.
Manually Connect: To enter the SSID of your network and the password manually, select this option. When done, press Enter to connect.
10.3.2. [bookmark: _Refd18e3080][bookmark: _Tocd18e3080][bookmark: _Toc54942105]Wi-Fi Settings Table
The available Wi-Fi Settings are listed in Table 7.
Table 7: Wi-Fi Settings
	Setting
	Option/Result

	Wi-Fi
	Press Enter to turn Wi-Fi On or Off

	Status
	Provides information about your current Wi-Fi status

	New connection
	Press Enter to create a new Wi-Fi connection

	Launch connection
	Connect to a Wi-Fi network known by your device

	Delete connection 
	Make your device forget a known Wi-Fi network

	Network settings
	Change advanced network settings, such as Mode, IP, Subnet mask, Gateway, and DNS

	Import Wi-Fi
	Import Wi-Fi network information from a file



10.4. [bookmark: _Refd18e3137][bookmark: _Tocd18e3137][bookmark: _Toc54942106]Choosing Bluetooth Mode Options
The following Bluetooth mode options are available on the Brailliant BI 40X.
· Bluetooth mode: On or Off
· Connect device: Connect the Brailliant with a paired Bluetooth device
· Disconnect device: Disconnect the active Bluetooth connection
· Delete paired device: Makes your device forget a Bluetooth device
11. [bookmark: _Customize_KeySofts_Main][bookmark: _Toc54942107]Customize KeySofts Main Menu
The Customization function allows you to take items off the Main menu of the Brailliant, in exception of the Options item and the Power off item. This feature is useful for beginners who wish to simplify the usage of their device.
To customize the main menu applications:
1. Go to the Main menu.
2. Select Options.
3. Press Enter. 
4. Go to Main menu applications.
5. Press Enter.
6. A list of the Main menu applications will appear. Go to the application you wish to take off the menu, and press on Enter to toggle it to Off. Pressing Enter again will toggle it back to On.
7. Press on Save to apply the changes.  
12. [bookmark: _Toc54942108]Change Region
To change the system language of the Brailliant BI 40X:
1. Go to the Main menu.
2. Select Options.
3. Select Change Region.
4. Select the Language option and press Enter. A list will appear on the display. 
5. Select the language of your choice from the list. 
6. Select Close.
7. You will be prompted to select the option Replace Braille default profile. If you click on Ok, a new Braille profile will be created with a Braille table allowing to read Braille menus in the selected language. Press Cancel if you wish to stay with your current Braille profile.
8. When prompted, reboot the Brailliant to apply the changes. 
13. [bookmark: _Toc54942109]Accessing and Using Online Services
[bookmark: _Hlk37938939]This Online Services menu contains online libraries included on your Brailliant. The Online Services are subscription-based and require you to enter your account credentials.
Note: Make sure you have an established internet connection with the Brailliant before using Online Services. 
Books from online libraries are downloaded in the Online-books folder of the Brailliant. All books are included in the Main Book list of the Victor Reader application.
13.1. [bookmark: _Toc54942110]Activating Bookshare and Downloading Books
[bookmark: _Hlk37939116][bookmark: _Refd18e3170]Bookshare® online library contains copyrighted content for people with qualifying print disabilities. More information about Bookshare is available from http://www.bookshare.org. 
You are able to search for books and download them to the Brailliant wirelessly. Newspapers and magazines are currently not available in the online search.
To activate the Bookshare service and download a book: 
1. Enter your Bookshare account email address and password. 
2. Select your preferred book format (DAISY or BRF).
3. Search books by title, author, full text search, and/or browse by categories. You can also search for the most recent or popular books.
4. Press Enter or a cursor routing key on a book to get more information. 
5. Use Previous and Next thumb keys to navigate between the title, author, and book description. 
6. Press Enter on the Download item to download the book to the Brailliant. 
13.2. [bookmark: _Toc54942111]Configuring, Managing, and Syncing an NFB Newsline Account
[bookmark: _Hlk37939337]If you have an NFB Newsline® account, the Brailliant allows you to connect to your account and download NFB material for reading in the Victor Reader.
Configure account: Enter your NFB Newsline credentials, select the issue update frequency, and determine whether your Brailliant should keep or delete outdated issues.
Manage publications: Select which material you wish to subscribe to. Subscribed material is underlined.
Sync content now: Downloads the latest issues of your subscribed material.
13.3. [bookmark: _Toc54942112]NLS Bard
The Brailliant can access BARD directly. You can view and download books from the most popular books list and the most recent books and magazines list. You can browse subject categories and search the collection. You can also download books and magazines from your wish list as well as add and remove items from it. Before you can access BARD, you must connect your device to a Wi-Fi network (see Connecting to a Wi-Fi Network for detailed instructions) and login to your BARD account.
13.3.1. [bookmark: _Toc54942113]Connecting to BARD for the first time
To access BARD, select NLS BARD from the Online Services Menu. The first time you do this, you will be prompted to enter your BARD username and password. You cannot log in with a temporary password. If you have a temporary password, you will need to use a web browser to create a permanent password and then log in with those credentials.
After typing your username, press Enter. You will be prompted to enter your password. Once typed, press the Enter key. You will briefly see the word "loading..." followed by "login successful."
Once you have logged into BARD successfully, each time you enter NLS BARD, you will see "login successful" and the first item of the NLS BARD Menu will appear.
13.3.2. [bookmark: _Toc54942114]Downloading Books and Magazines from BARD
The NLS BARD menu contains the following items:
· Most Popular
· Most Recent Books
· Most Recent Magazines
· Browse Categories
· Browse magazines 
· Search Collection
· Wishlist
· Download history 
· Remove Account
Each of these menu items will take you to a list of books or magazines. Press Enter on a book to get more information. Use the PreviousUp and NextDown thumb keys to navigate among the title, author and the book description. Press Enter on the Download item if you wish to download the book to your Brailliant.
13.3.3. [bookmark: _Toc54942115]Reading a Book you have downloaded
After you have downloaded a book or magazine, you can download additional items, or you can read one of them. To read an item, return to the Main Menu by pressing the Home button . Navigate to  Victor Reader and press Enter. Press Enter on Book List. Here you will find your downloaded items. Press Enter on the title you wish to read and you will be at the beginning of the book.
14. [bookmark: _Toc54942116]Exam Mode
[bookmark: _Hlk54687245]The Exam mode is used to block certain functions and applications from the Brailliant for a certain amount of time. While the Exam mode is active, you will only have access to the Terminal functions. Note that in the exam mode, the Bluetooth connection is deactivated; Terminal mode is only accessible via USB. All other applications and the use of an external memory (USB drive) are blocked while this mode is active.
When activating the Exam mode, you will be prompted to enter a time between 1 and 240 minutes (4 hours) and will be asked to enter a desired password to turn off the exam mode. 
To unlock the device, you will need to either wait for the selected time to run out or enter the selected password. 
Upon restarting the device, if the period selected is not completed yet, the device will automatically go back to Exam mode.
To activate the Exam mode:
1. Go to the Main menu.
2. Select Options.
3. Press Enter. 
4. Go to Activate Exam mode.
5. Press Enter.
6. Enter the desired time (between 1 and 240 minutes).
7. Enter the desired password to unlock the exam mode.
8. Press Ok.
15. [bookmark: _Toc487351481][bookmark: _Toc54942117][bookmark: _Refd18e3210][bookmark: _Tocd18e3210]Technical Specifications
15.1. [bookmark: _Toc54942118]Navigation components
· 4 Thumb keys
· 8-key Braille keyboard
· 2 Space bars
· Cursor routing keys
· 6 Command keys
15.2. [bookmark: _Toc54942119]Long-life battery
· Lasts up to 15 hours
· Recharges from PC through USB port
· Auto shut-off
· Lithium-ion polymer battery
· Compatible with any standard USB A/C adapter
15.3. [bookmark: _Toc54942120]Connectivity
· USB 2.0
· Wi-Fi 2.4 GHz & 5 GHz
· Bluetooth V5
15.4. [bookmark: _Toc54942121]Portability
Dimensions: 305 mm x 90 mm x 21.8 mm
Weight: 720 g 
16. [bookmark: _Toc54942122]Updating the Brailliant BI 40X
When connected to the Internet, Brailliant regularly looks to see if a newer version is available for download. If a new version is available, Brailliant asks if you wish to download the update. Select Ok by pressing the Previous or Next thumb key to download the update now or Cancel to update it later. You can continue to use the Brailliant while the update is downloading.
After a few minutes, Brailliant asks you to install the downloaded update. Select Ok to install the update. The Brailliant reboots and a progress indicator line is shown on the braille display. 
At the end of the update process, all 8 dots of the 40 braille cells raise one column at a time and then the device shuts down.
You can also manually verify if an update is available. 
To verify an update manually:
1. Go to the Main menu.
2. Select Options.
3. Press Enter. 
4. Go to the About item.
5. Press Enter. 
Alternatively, you can use the shortcut Space + I to open the About dialog. Then, press ‘c’ a few times until you see Check for update. Press Enter. 
17. [bookmark: _Refd18e3230][bookmark: _Tocd18e3230][bookmark: _Toc54942123]Customer Support
[bookmark: humanware]For customer support, please contact the HumanWare office nearest you or visit our Website at: www.humanware.com/support
Global: support@humanware.com
North America: 1 800 722-3393
us.support@humanware.com
Europe: (0044) 1933 415 800
eu.support@humanware.com
Australia / Asia: (02) 9686 2600
au.sales@humanware.com
18. [bookmark: _Toc54942124][bookmark: _Toc477772532][bookmark: _Toc403987875]Proper Trademark Notice and Attributions 
macOS is a registered trademark of Apple Inc. 
JAWS is a registered trademark of Freedom Scientific, Inc. in the United States and other countries.
Bookshare® is a registered trademarks of Beneficent Technology, Inc. 
NFB Newsline is a registered trademark of the National Federation of the Blind
Bluetooth is a registered trademark of Bluetooth SIG, Inc. 
IOS is a trademark or registered trademark of Cisco in the U.S. and other countries and is used under license. 
All other trademarks are the property of their respective owners. 
19. [bookmark: _Toc54942125]End User License Agreement
By using this Product (Brailliant BI 40X), you agree to the following minimum terms:
0. License Grant. HumanWare grants to End User a non-exclusive, non-transferable right and licence to use the Software on this product.
0. Ownership of Software. End User acknowledges that HumanWare retain all right, title and interest in and to the original, and any copies, of software which is incorporated into this product. End User agrees not to: modify, port, translate, decompile, disassemble, reverse engineer, or make public in any way the software of this Product.
20. [bookmark: _Refd18e3590][bookmark: _Tocd18e3590][bookmark: _Toc54942126]Warranty
Manufacturer Warranty
This device is a high-quality product, built and packaged with care. All units and components are guaranteed against any operational defects for 2 years for all countries.
Warranty covers all parts (except battery) and labor. If any defect should occur, please contact your local distributor or the manufacturer technical assistance line.
Note: Warranty terms may periodically change, please consult our website for the latest information.
Conditions and Limitations:
Please keep your bill of purchase in a safe place as it may be required for a warranty repair or replacement. Please retain your original. If the unit has to be returned, please use the original packaging. This warranty applies to all cases where the damage is not a result of improper use, mistreatment, negligence or acts of God.
North America:  In addition to the warranty, you can also purchase a Service Contract to prolong coverage for one year and also benefit from the cleaning service. Please refer to our web site: http://www.humanware.com/  
Or contact us by E-mail at us.info@humanware.com  or call 1(800) 722-3393
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